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Welcome to ProSeries® tax software

For information about specific topics after you install the ProSeries program:

● See the ProSeries User’s Guide (as explained on page 36 of this guide).
● Enter keywords or a question in the Search Help field on the Help toolbar, then click 

Search. (The Help toolbar is located near the top-right corner of the ProSeries 
window.)

Important: If you want information about a specific type of return, start or open a return 
of that type before you start the search.

What’s new with ProSeries tax software for 2004
The following table summarizes major enhancements to ProSeries tax software for the 
2004 tax year. This is not an all-inclusive list of changes.

For information about this topic... Look here...

What’s new with ProSeries tax software for 2004 Page 1

Computer system requirements Page 3

Getting ready for the 2004 tax season Page 4

Getting your computer system ready Page 7

Installing ProSeries software for the 2004 tax year Page 9

Setting up the ProSeries program Page 14

Setting ProSeries options Page 17

Transferring data from ProSeries 2003 client files Page 21

Product licensing Page 23

Keeping your ProSeries tax products up-to-date Page 25

Preparing your clients’ federal and state returns Page 27

Setting up other ProSeries features Page 33

Getting information and help Page 34

On-screen ProSeries User’s Guide Page 36

ProSeries.com and My ProSeries.com Page 36

Electronic Filing Page 37

Bank Products Page 47

Feature... What’s new...

New products • ProSeries State Partnership returns — Hawaii, New Hampshire, Utah

• ProSeries State Estate Tax returns — California
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For information about some of the enhancements to specific ProSeries tax products:

● See the product Release Notes that accompanied the ProSeries CD, or

● Click the Help Center button on the ProSeries toolbar, choose ReadMe 
Information in the Help Center, then select the ProSeries tax product, or

● Click the Help Center button on the ProSeries toolbar, then select What’s 
New This Year? in the Help Center, or

● Start a new return or open a previously-saved return for that ProSeries tax product, 
then go to the Search Help field (near the top-right corner of the ProSeries window).
Type keywords or a question in the Search Help field, then click the Search button.
Review the list of search results in the Help Center. Click the blue, underlined title of a 
search result to see more information.

Electronic filing 
and Bank Products

• Use the new E-File command on the main menu bar for all electronic filing 
and bank products commands. (The Electronic Filing and Bank Products 
commands have been removed from the File menu.)

• Filter clients in the EF Center according to status using three new tabs — 
All, Pending, and Accepted.

E-file 
Massachusetts 
business returns 
and corporate 
extensions

• You can file Massachusetts corporation, S corporation, partnership, and 
fiduciary returns electronically. You also can file Massachusetts 
corporation and S corporation extensions electronically. (Massachusetts 
has mandated that Massachusetts business returns and corporate 
extensions for the 2004 tax year be filed electronically.)

E-file Michigan 
Single Business 
Tax returns

• You can file Michigan Single Business Tax returns electronically. 
(Michigan has mandated that Michigan Single Business Tax returns for the 
2004 tax year be filed electronically.)

Missing client 
information

• You can use the Missing Client Information system to track client 
information. From HomeBase, you can identify client returns that are 
missing information, print lists of missing client information, and send 
reminder e-mails to clients.

Part-year resident 
and nonresident 
state returns

• For individuals who must file more than one state return, new worksheets 
in ProSeries/1040 and enhancements to the ProSeries State products help 
you allocate income to each part-year resident and nonresident state 
return.

Active duty 
military wages and 
state returns

• Additions to the Form W-2 Worksheet in ProSeries/1040 and 
enhancements to the ProSeries State products help you calculate 
deductions, credits, and special tax treatment on state returns for active 
duty military personnel.

Billing and 
invoicing

• You can charge per line of data on Schedule B in ProSeries/1040 returns.

• You can charge per line of data on Schedule D in ProSeries/1040 returns.

Product updating • The process for updating previously-installed ProSeries products has been 
improved.

Network 
performance

• More functionality resides on each workstation (and less on the network 
server) when ProSeries software is installed for network use this year, so 
the program runs faster on each workstation.

Feature... What’s new...

Ge
tt

in
g 

Re
ad

y



Getting Ready 3

Computer system requirements
Make sure that each computer on which you intend to use ProSeries software for the 2004 
tax year meets or exceeds the minimum requirements for all relevant components.

The minimum requirements and recommendations for ProSeries 2004 software differ from 
those for ProSeries 2003 software.

The minimum requirements shown below should provide adequate performance on most 
computer configurations. Systems that don’t meet the minimum requirements may not 
operate as designed.

For more information about how system requirements can affect ProSeries operation, go to 
www.proseries.com.

Component Recommendation Minimum Requirement

Computer Pentium 4, 1.3 GHz or faster Pentium 266 MHz or equivalent AMD 
processor

Memory 512 MB RAM or more. More memory 
normally results in improved 
performance.

128 MB RAM. More memory may be 
required if you install many products 
and have a large number of clients.

Hard disk space 2 GB or more, depending on the 
number of products you install and 
the number of clients you have.

650 MB. More space may be required 
if you install many products and have 
a large number of clients.

Windows 
operating 
system

One of the following:

• Windows 2000 (service pack 3 or 
later)

• Windows XP (Home or Professional 
edition)

One of the following:

• Windows NT (version 4.0, service 
pack 6a or later)

• Windows 98 (second edition)

• Windows ME

Screen 
resolution

1024 x 768 or higher 800 x 600

Printer Hewlett-Packard LaserJet Series 4 or 
later (or 100% compatible) with at 
least 1 MB of printer memory

Hewlett-Packard LaserJet or PCL 
compatible with 1 MB of printer 
memory

Disk drive CD-ROM 12X or faster CD-ROM 6X or faster

Internet 
connection

High-speed Internet connection (such 
as T-1, DSL, or cable modem) or 56 K 
modem

28.8 K modem

Internet 
Browser

Microsoft Internet Explorer 6.0 or later Microsoft Internet Explorer 5.5, 
service pack 2 or later (Internet 
Explorer 6.0 is installed if Internet 
Explorer 5.5, service pack 2 or later 
isn’t already installed).

Internet 
Service 
Provider (ISP)

ProSeries software works with most 
ISPs. Contact your ISP if you have a 
specific question.

None required. However, an ISP is 
required for features that use the 
Internet, such as online delivery of 
products and electronic filing.
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Getting ready for the 2004 tax season
Know your responsibilities. You and your clients are responsible for correctly reporting all 
information that is required by the Internal Revenue Service or applicable state taxing 
agency, and for the accuracy of each return that you file.

Be familiar with your computer system. If you’re unfamiliar with the basic operation of 
your computer, your Microsoft Windows operating system, or your computer network (if 
applicable), read the owner’s guide for your computer, Windows help, or the network 
documentation.

Understand the ProSeries License Agreement. You must read and understand the ProSeries 
License Agreement. The ProSeries License Agreement appears at the start of the installation 
procedure. After the software has been installed, you can review the ProSeries License 
Agreement in the Help Center or the ProSeries User’s Guide. Please note the following 
conditions of the ProSeries License Agreement:

● You are licensing the software for use by a named entity and its employees at one 
identified location.

● You are representing to Intuit® that the firm name and address you provide is the 
primary firm name and location used in the normal course of business.
• This is the name and address under which you market yourself and your 

professional services.
• This firm name and address will appear in the “Paid Preparer” designation on tax 

returns.
● You may enter information about as many preparers as needed, provided that they all 

are employees of the firm listed at that particular address.
● Multiple preparers who operate as separate and distinct firms—even if they share office 

space—are considered to be unique and each preparer must purchase a license for his 
or her own copy of the ProSeries software.

Preparing for electronic filing
If you want to file returns (or extension request forms) electronically, you must be able to 
connect to the Internet from the computer on which you install the ProSeries program. In 
addition, you must have an IRS-issued Electronic Filing Identification Number (EFIN).

If you are new to electronic filing or no longer have a valid EFIN, you can apply for one 
using either of the following methods:

● Online. To use the new IRS e-file application, go to www.irs.gov, choose the e-file link, 
then click on the e-services link in the e-file for Tax Professionals section.

● Form 8633. Submit Form 8633, Application to Participate in the IRS e-file Program.

Important: You must use the version of Form 8633 dated July 2003. If you submit 
an earlier version, the IRS will reject your application. The IRS recommends that you 
submit your application at least 45 days prior to the date that you intend to begin 
filing returns electronically. You can find Form 8633 and information about electronic 
filing at www.proseries.com. Select E-Filing, then How to E-File. You can also find 
Form 8633 and information about electronic filing at the IRS Web site, which is
http://www.irs.gov/.

Tip: If you have additional questions about electronic filing, call the IRS e-help desk at
1-866-255-0654.
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State enrollment requirements
Some states require additional electronic filing enrollment paperwork. Verify the electronic 
filing enrollment requirements for each state where you plan to file returns electronically.

You can link to each state taxing agency’s Web site from www.proseries.com. Select 
Resources, then select State Links.

For more information about electronic filing, see “Filing returns electronically” on 
page 37.

Preparing to offer bank products
When you file your clients’ individual returns electronically, they can receive loans based 
on their expected federal refunds in the form of Refund Anticipation Loans (RALs), Refund 
Transfers (RTs), and Refund Transfer Direct Deposits (RTDDs). In addition, your fees are 
deducted from the client’s refund and deposited into your bank account electronically.

Before you can offer bank products to your clients, you must first apply to Santa Barbara 
Bank & Trust, Republic Bank, or First Security Bank to participate in their banking 
products program. To apply, go to www.proseries.com, select E-Filing, select Bank 
Products, then follow the instructions.

For more information about bank products, see “Overview of Bank Products” on page 47.

Preparing to accept major credit cards and eChecks
You can use the ProSeries/Merchant Account Service to accept payment for your services 
by major credit cards and e-Checks.

If you aren’t already a ProSeries/Merchant Account Service customer, you must apply for 
the ProSeries/Merchant Account Service program. To apply, go to www.proseries.com, 
select Products, select Services, then select Merchant Account Services.

Tip: To apply for the ProSeries/Merchant Account Service program after you install the 
ProSeries program, go to the Tools menu, choose Accept Credit Cards/eChecks, then choose 
Sign Up.

Ordering presentation folders and envelopes
To purchase presentation folders and window envelopes, call Professional Tax Products
at 1-888-236-8137, or go to the Professional Tax Products Web site at
http://www.proseriessupplies.com.
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Preparing for ProSeries setup
You can use each ProSeries tax product and electronic filing product on an unlimited basis 
or a pay-per-return basis.

Using ProSeries products on an unlimited basis
● Tax products. When you use a ProSeries tax product on an unlimited basis, you pay a 

fixed fee to purchase that product, but you don’t pay a fee to print or convert returns 
for electronic filing.

● Electronic filing products. When you use a ProSeries electronic filing product on an 
unlimited basis, you pay a fixed fee to purchase that product, but you don’t pay a fee 
to transmit returns electronically.

Using ProSeries products on a pay-per-return basis
● Tax products. When you use a ProSeries tax product on a pay-per-return basis, you 

don’t pay a fee to purchase that product, but you must authorize payment for each 
return before you can print it or convert it for electronic filing.

● Electronic filing products. When you use a ProSeries electronic filing product on a 
pay-per-return basis, you don’t pay a fee to purchase that product, but you must 
authorize payment for each return before you can transmit it electronically.

Important: Service and delivery fees are separate from product purchase fees.

Important: If you want to use a ProSeries product on an unlimited basis, call ProSeries 
Sales at 1-800-934-1040 or order online at www.proseries.com. The product information in 
your customer record will be updated. Product licensing can be done automatically if your 
computer is connected to the Internet (which is the recommended method), or you can use 
the manual method for product licensing (by selecting License Products from the ProSeries 
Tools menu).

When you install ProSeries software, you’ll select the tax products that you want to install. 
If you haven’t already purchased the Unlimited version of a tax product or corresponding 
electronic filing product, the Pay-Per-Return version of that product will be installed.

Tip: To see more information about Pay-Per-Return products before you install ProSeries 
software, go to www.proseries.com, choose Resources, select ProSeries User’s Guide, then 
see chapter 8, “Using Pay-Per-Return Products.”

You will be prompted for information about the following topics during ProSeries setup. 
(You can enter this information as you use ProSeries later, if you prefer.)

For this topic... You should know this...

Firm and Preparers Basic information about your firm and the preparers who will be using the 
ProSeries software

Electronic Filing Information about the person who will be the electronic filing contact for 
your firm, if you’re going to offer electronic filing to your clients

Bank Products Your bank products registration information, including information about 
the bank account where your fees will be deposited by Santa Barbara Bank 
& Trust, if you’re going to offer bank products to your clients through 
Santa Barbara Bank & Trust

Billing How you want to set up ProSeries billing options such as standard fees, 
hourly charges, and per-form charges
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Getting your computer system ready
You can install ProSeries software for stand-alone use or for network use. First, decide how 
you will install and use ProSeries software, then get your computer(s) ready.

Important: Before you can install ProSeries software for network use, you must purchase 
the ProSeries/Network Version product.

Decide how you are going to use ProSeries software
How you install and then use ProSeries software depends on several factors, including the 
number of computers on which you want to use ProSeries.

One computer. If you’re going to use ProSeries software on one computer, install the 
program for stand-alone use on that computer’s hard drive.

See “Installing ProSeries software for the 2004 tax year” on page 9.

Multiple computers. If you’re going to use ProSeries software on more than one computer, 
you can install the program for stand-alone or network use.

● Stand-alone use. If each preparer maintains an independent set of clients, install the 
ProSeries program for stand-alone use on the hard drive of each computer.
See “Installing ProSeries software for the 2004 tax year” on page 9 for instructions.

● Network use. If preparers regularly share tasks and review returns for other preparers, 
install the ProSeries program for network use.
1. Install the ProSeries network components to a shared drive from the computer you 

choose to be the ProSeries Admin workstation. You’ll also install and set up the 
ProSeries program on the ProSeries Admin workstation at that time.
Any computer (including the network administrator’s workstation) can be the 
ProSeries Admin workstation. However, we strongly recommend that the ProSeries 
Admin workstation have an Internet connection to help ensure that you always 
have the latest version of the ProSeries tax products that you use.

2. Install and set up the ProSeries program on each additional computer that will be a 
workstation that runs the ProSeries program (and that will access ProSeries 
network components and client files from the shared drive where ProSeries is 
installed).

For instructions, see the ProSeries Network Installation Guide that you received with 
this guide if you purchased ProSeries/Network Version.

Important: If a preparer is going to prepare returns on a laptop or notebook computer 
that will be mobile (in a manner permitted by the ProSeries Software License Agreement), 
install ProSeries for stand-alone use on the hard drive of that laptop or notebook 
computer.

Tip: If you install ProSeries software for stand-alone use on a laptop or notebook 
computer, be sure to use the Copy/Backup and Restore commands on the Client File 
Maintenance menu (which is accessed from the File menu) when “moving” client files 
from the network to the laptop or notebook, or from the laptop or notebook to the 
network.
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Prepare your computer system
We suggest you review the following before installing ProSeries software.

Internet connectivity
Having an Internet connection allows you to take advantage of ProSeries features such as 
online delivery of tax products and tax product updates, product licensing, electronic 
filing, bank products, and the www.proseries.com and www.my.proseries.com Web sites.

We recommend that the following have a valid Internet connection before you install 
ProSeries software:

● Each computer on which you will install ProSeries software for stand-alone use
● The ProSeries Admin workstation from which you install ProSeries software for 

network use, because all product downloads and product updates must be done at the 
ProSeries Admin computer

Computer performance
We strongly recommend that you do the following for each computer that will run 
ProSeries software:

● Run the Scan Disk and Disk Defragmenter system tools to correct any errors on the 
hard drive and speed up access to the contents of the hard drive. (For more 
information, refer to Windows Help.)

● Use virus-protection software to check for viruses on the hard drive.

Know the location of your ProSeries 2003 client files
ProSeries software for the 2004 tax year can transfer relevant data from ProSeries 2003 
client files into new ProSeries 2004 client files.

If you used ProSeries software for the 2003 tax year, make sure you know the location of 
last year’s ProSeries client files—especially if your ProSeries 2003 client files are stored on 
3.5-inch disks or other external storage media.

Tip: The default installation location for the ProSeries 2003 client file directory was 
C:\ProWin03\03Data.

Know the location of the other important data files
If you use QuickBooks® software, Quicken® software, Intuit EasyACCT® software, ProSeries/
Fixed Asset Manager, a trial balance program, or any other software from which you 
expect to import client data, make sure you know where the relevant data files are located.



Install and Setup 9

Installing ProSeries software for the 2004 tax year
This section explains how to install ProSeries software on each computer that will use 
ProSeries independently. If you purchased ProSeries/Network Version, refer to the 
ProSeries Network Installation Guide for instructions.

You install ProSeries software from the first ProSeries CD that you receive. Each ProSeries 
CD contains the latest version of each ProSeries tax product that’s currently available. (For 
details about each ProSeries CD, see “Software service and delivery information” on 
page 25.)

When you run the ProSeries installation program, select each ProSeries tax product that 
you expect to use for the 2004 tax year—even if you’re only installing Client Organizer 
from the ProSeries Head Start CD. The installation program will install each tax product 
that you selected, provided the tax product is on the ProSeries CD. The ProSeries User’s 
Guide will also be installed.

Important: We strongly recommend that you install Client Organizer from the Head Start 
CD so you can receive other products via the Internet as soon as possible. For more 
information, see “Keeping your ProSeries tax products up-to-date” on page 25.

Before you install ProSeries software for the 2004 tax year, note the following important 
information:

● Release Notes. Read the printed Release Notes and any other material that 
accompanied the ProSeries CD.
THE RELEASE NOTES MAY CONTAIN, AMONG OTHER THINGS, ADDITIONAL 
LICENSING TERMS THAT GOVERN THE USE OF THE PROSERIES SOFTWARE AND 
RELATED SERVICES.

● Packing slip. The packing slip that accompanied the ProSeries CD contains the 
following information that you will need:
• Your Customer Number and ZIP code
• The install code for ProSeries/Network Version, if you purchased

ProSeries/Network Version
• The install code for ProSeries/Practice Manager, if you purchased that program
• The install code for ProSeries/Fixed Asset Manager, if you purchased that program

Tip: The only product licensing information on the packing slip is your Customer Number 
and ZIP code.

Important: If you are installing ProSeries software on a server and workstations for 
network use, refer to the ProSeries Network Installation Guide for instructions.

Installing ProSeries software for stand-alone use
To install ProSeries software on a computer for stand-alone use:

1 Close all open applications and turn off any virus-protection utilities on the computer.

2 Insert the ProSeries CD into the appropriate drive.

Don’t remove the CD from the drive until you finish installing products.

3 In the ProSeries Installation dialog box, click Tax Preparation.

If the ProSeries Installation dialog box doesn’t appear automatically:
a. Go to the Windows taskbar, click Start, then choose Run.
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b. In the Run dialog box, type X:\CDSETUP (where X represents the letter of 
the drive containing the ProSeries CD), then click OK.

c. When the ProSeries Installation dialog box appears, click Tax Preparation, 
then continue to Step 4.

4 In the Welcome dialog box, click Next when you’re ready to continue.

5 A System Warning dialog box appears if your computer doesn’t meet the minimum 
system requirements for the ProSeries 2004 software. (For more information, see 
“Computer system requirements” on page 3.)
If the System Warning dialog box appears, read the information, then do one of the 
following:
• Click Cancel to exit the installation program, then correct the situation(s) identified 

in the System Warning dialog box. After your computer meets the minimum system 
requirements for the ProSeries 2004 software, go back to page 9 and start the 
installation procedure again.

• Check the box indicating that you understand you may not receive technical 
support for issues that you may encounter while using the ProSeries program, then 
click Next to continue to Step 6.

Important: We strongly recommend that you click Cancel and correct the situation(s) 
identified in the System Warning dialog box. For information about how system 
requirements can affect ProSeries operation, go to www.proseries.com.

6 In the Software License Agreement dialog box, read the ProSeries License Agreement 
to understand the scope of your rights to use ProSeries software.
• Select I accept the agreement if you agree to accept all the terms of the ProSeries 

License Agreement, then click Next and continue to Step 7.
• Select I do not accept the agreement if you don’t agree to accept all the terms of 

the ProSeries License Agreement, then click Cancel and exit the installation 
program.

Important: If for any reason you find the ProSeries License Agreement unacceptable, 
do not install the software. Contact ProSeries Customer Service for a refund instead.

7 In the Select an Installation Type dialog box, click Next.

8 In the Select Destination Directory dialog box, do one of the following:

• Click Next if you want to install ProSeries software in a \PROWIN04 directory on 
the drive that’s shown in the dialog box. (That drive will be C: or the drive on 
which last year’s ProSeries was installed.) Proceed to Step 10.

• Click Browse if you want to install ProSeries software to a different drive or 
directory. Continue with Step 9.

Stand Alone is the default selection.
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9 In the Select Folder dialog box, take the following steps:

a. Select the drive where you want to install ProSeries software.
b. After selecting the drive, type the folder name \ProWin04 in the Folder 

name field so that it appears after the drive you selected, then click OK.
PROWIN04 directory. For best results, use PROWIN04 as the name of your 
2004 ProSeries directory. Don’t install ProSeries software to the root of a 
drive.

c. When prompted to create the PROWIN04 directory in the location that 
you’ve specified, click Yes.

d. When you return to the Select Destination Directory dialog box, click Next. 
Continue with Step 10.

10 In the Tax Year 2004 Product Selections dialog box, select the products that you 
expect to use for the 2004 tax year, then click Next.
Tip: If you used ProSeries software for the 2003 tax year, the products that were 
installed last year may already be selected.

Tip: Every ProSeries tax product for 2004 is shown in this dialog box, including 
products that may not be available yet. Select all ProSeries tax products that you 
intend to use this tax season. You can install additional products later, as described in 

Click here if you want to install your 
ProSeries products on a drive other 
than the drive that’s shown.

See Step 9 for additional 
instructions.

This section explains 
how to use this dialog 
box.

These check boxes are 
for federal products.

At least one federal 
product must be 
selected.

Tip: If you select a 
state product, be sure 
to select the 
corresponding federal 
product.

These check boxes are for state products.
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“Keeping your ProSeries tax products up-to-date” on page 25. Any products you 
select here that you haven’t purchased as unlimited will be installed for pay-per-
return use.

11 If any of the products you selected aren’t on the CD, you’ll see the Installation Note 
dialog box. Review the list of products that will be installed later (when they become 
available), then click OK. (For more information, see “Keeping your ProSeries tax 
products up-to-date” on page 25.)

12 In the E-mail Alert Registration dialog box, click Accept or Decline, depending on 
whether you accept the terms of the E-mail Alerts system, then click Next.
Tip: E-mail alerts inform you when the products you selected for installation become 
available or are updated. E-mail alerts also inform you about support issues, and 
present information relevant to your ProSeries products.

13 Review the E-mail Alert Selection on Multiple Computers dialog box, then click OK.

14 In the Disk Space Confirmation dialog box, review the Required Space and Available 
Space information, then click Next.
The installation program installs all available ProSeries tax products that you selected, 
then verifies that all applicable files were installed correctly. Continue with Step 15.
Installation Failed dialog box. If you see this dialog box, a product was not installed 
properly. Click Help to find a possible solution, then click Exit to exit the installation 
program.

15 Additional components. Wait while additional components, such as any necessary 
fonts, Internet Client software, the ProSeries User’s Guide, WexTech® AnswerWorks® 
software, and ProSeries Product Licensing components are installed. Dialog boxes and 
progress bars keep you informed.

16 Internet Explorer. If Microsoft Internet Explorer 5.5, service pack 2 or later isn’t 
installed on your computer, the installation program installs Internet Explorer 6.0 
before continuing. ProSeries software requires portions of Internet Explorer 5.5, 
service pack 2 or later to run properly.

Important: If ProSeries installs Microsoft Internet Explorer, you are prompted to 
restart your computer. After the computer restarts, the installation program will finish 
the ProSeries installation procedure.

17 Restart Windows message. Restart your computer if you are prompted to do so.

If the installation program doesn’t resume after you restart the computer, 
start the ProSeries program by double-clicking the ProSeries 2004 shortcut 
icon on your Windows desktop. The Connected Customer Wizard will begin 
automatically. Go to “Setting up the ProSeries program” on page 14 now.

18 Setup Complete. In the Setup Complete dialog 
box, click Finish, then continue with Step 19.
We recommend that you leave the check mark 
in the Launch ProSeries option.

19 If the Launch ProSeries option was selected: 
The Connected Customer Wizard begins 
automatically. Proceed to “Setting up the 
ProSeries program” on page 14.
If the Launch ProSeries option wasn’t 
selected: You return to the ProSeries 
Installation dialog box that’s discussed in Step 3, which starts on page 9. Click Exit to 
return to the Windows desktop. Continue with Step 20.
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20 After you return to the Windows desktop, start the ProSeries program by 
double-clicking the ProSeries 2004 shortcut icon. The Connected Customer 
Wizard will begin automatically.

21 Continue with “Setting up the ProSeries program” on page 14.

Troubleshooting suggestions
If you have difficulty installing or starting the ProSeries program, see the troubleshooting 
suggestions in the following table.

If this occurs... Do this...

A dialog box informs 
you that your computer 
doesn’t have enough 
disk space

1. Go to the Start menu, point to Programs, then Accessories, then 
System Tools, and then click Disk Cleanup.

2. Try to install the ProSeries software again.

3. If there still isn’t enough disk space, remove unused programs or 
data from the hard drive.

A dialog box informs 
you there was an error

1. Write down the error message, then restart the computer.

2. Go to the Start menu, point to Programs, then Accessories, then 
System Tools, and then click ScanDisk.

3. After ScanDisk is complete, go to the Start menu, point to Programs, 
then Accessories, then System Tools, and then click Disk Defragmenter.
4. After Disk Defragmenter is finished, run your virus-protection 
software.

5. Clean the ProSeries CD with a soft cloth, then try to install the 
ProSeries software again.

The ProSeries program 
doesn’t start when it 
should

1. Restart the computer.

2. Make sure no other applications are running.

3. Double-click the ProSeries 2004 icon on the desktop.

You still are unable to 
install or start the 
ProSeries program

Start your Internet browser, then go to www.proseries.com to see 
additional troubleshooting solutions.

You are unable to 
resolve the problem

Call ProSeries Technical Support. To save time, gather as much 
information as possible, including any error messages. If your 
computer is networked, have your network administrator available.
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Setting up the ProSeries program
The first time that you start the ProSeries program, the Connected Customer Wizard helps 
you set up the program if there’s a valid Internet connection.

Network. The ProSeries program should start from the ProSeries Admin workstation the 
first time. Don’t set up other workstations to run the program until you’ve set up ProSeries 
from the ProSeries Admin workstation.

If the computer has a valid Internet connection
If the computer has a valid Internet connection, the Connected Customer Wizard performs 
the following important tasks to save you time:

● Internet Connection. Connects via the Internet to an Intuit ProSeries server that 
contains customer information.

● Firm information. Retrieves the name and address of your firm from the Intuit 
ProSeries server.

● E-mail address. Retrieves your firm’s e-mail address from the Intuit ProSeries server.
● Product licensing. Licenses your ProSeries tax software to your firm, based on your 

Customer Number, ZIP code, and information in the customer database on the Intuit 
ProSeries server.
• Products you’ve purchased as Unlimited are licensed as Unlimited.
• All other products are licensed as Pay-Per-Return.

Important: Product licensing information is not printed on the packing slip. For 
more information, see “Product licensing” on page 23.

● Product updates. Checks for updates to the products that were installed from the 
ProSeries CD, then downloads and applies the relevant updates, if any.

● New products. Checks for products that you selected for installation that weren’t 
installed from the ProSeries CD, then downloads and installs those products, if any.

Tip: If you need to edit information that the Connected Customer Wizard retrieves from 
the Intuit ProSeries server, you can do that in the ProSeries program later.

Proceed to “Using the Connected Customer Wizard” below.

If the computer doesn’t have a valid Internet connection
If the computer doesn’t have a valid Internet connection, you see a dialog box that 
explains the benefits of being connected and asks whether you want to start the Internet 
Connection Setup Wizard. If you don’t establish a valid Internet connection, the Options 
Setup Wizard begins. Proceed to “Setting ProSeries options” on page 17. You’ll have an 
opportunity to license your products and to enter your firm’s name and address later.

Using the Connected Customer Wizard
When the Connected Customer Wizard starts, go to:

• Step 1 if the computer doesn’t have a valid Internet connection
• Step 2 if the computer has a dial-up Internet connection
• Step 3 if the computer has a valid, non-dial-up Internet connection
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1 If the computer doesn’t have a valid Internet connection, a dialog box explains the 
benefits of being connected.
• If you think you might be able to establish a valid Internet connection, click Yes to 

run the Internet Connection Setup Wizard.
After you establish a valid Internet connection and return to the Connected 
Customer Wizard, continue with Step 2.

• If you know you won’t be able to establish a valid Internet connection now, click 
No to exit the Connected Customer Wizard.
The ProSeries program will start automatically. Proceed to “Setting 
ProSeries options” on page 17.

Tip: To establish a valid Internet connection at a later time, go to the 
ProSeries Help menu and choose Internet Connection Setup.

2 If the computer has a dial-up Internet connection, you are prompted to connect to 
the Internet if the computer isn’t currently connected. After you connect to the 
Internet, continue with Step 3.

3 In the Connected Customer dialog box, click Choose Products to Install if you want to 
view the products that you selected to install, or if you want to select additional 
products for installation. Click Next in the Connected Customer dialog box when 
you’re ready to continue to Step 4.

4 The Customer Information dialog box appears so you can enter or verify your 
Customer Number and ZIP code. (See the Sold To: area on the ProSeries packing slip.)

Click here to see the Tax Year 
2004 Product Selections 
dialog box.

Click here when you’re ready 
to continue.

These numbers should match the 
Customer Number and ZIP code 
that are printed in the Sold To: 
area of your packing slip.

A different Customer Number and 
ZIP code might appear in the Ship 
To: area of your packing slip.
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5 Click Next.
The Progress dialog box keeps you informed about what the Connected Customer 
Wizard is doing.
• The Connected Customer Wizard adds a check mark when it successfully completes 

a task.
• If the Connected Customer Wizard is unable to complete a task, you’ll see an “X” 

instead.

6 Click Next after the Connected Customer Wizard finishes the setup tasks.

7 In the Verify Firm Information dialog box, review the information that appears. This is 
the information that we have on file for your firm (based on your Customer Number 
and ZIP code).

Important: Review this information carefully. The ProSeries program prints this 
information on all returns prepared by your firm.

8 Click Next.
• If you selected Yes, you see the Verify EMail Address dialog box. Skip to Step 11.
• If you selected No, you see the Enter Firm Information dialog box. Continue with 

Step 9.

9 Enter or edit your firm’s name and address, then click Next.

Click Yes if your firm 
information is correct.

Click No if you want to enter or 
edit your firm information.
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10 If you make significant changes to your firm’s name or address, you see the Warning 
dialog box that’s shown next. Call Customer Service to update your firm information 
in our records, then click OK to continue.

11 In the Verify EMail Address dialog box, enter or verify your e-mail address, then click 
Next.

12 The Sending Changes to Server dialog box keeps you informed about what the 
Connected Customer Wizard is doing. When it’s done, click Next.

13 When the Product/Update Summary dialog box appears, review the list of new 
products and product updates that are available, if any. When you’re ready to 
continue, click Continue.

14 If there are new products or product updates to download, wait while the Connected 
Customer Wizard downloads and installs those new products and product updates.

15 When the Connected Customer Wizard finishes, the Prior Year Settings Transferred 
dialog box appears or the Options Setup Wizard begins so you can set up various 
ProSeries options. Proceed to “Setting ProSeries options” next.

Setting ProSeries options
The first time this year's ProSeries program starts, it transfers preferences and settings that 
you used with last year’s ProSeries program if it locates the file with that option 
information on your system.

Important: If you installed ProSeries for network use, the program transfers last year's 
preferences and settings only if it starts from the ProSeries Admin workstation the first 
time.

● Not Transferred. If the program wasn’t able to transfer last year’s ProSeries 
preferences and settings, the Options Setup Wizard starts. Proceed to the next section, 
“Using the Options Setup Wizard.”

● Transferred. If the program transferred last year’s ProSeries preferences and settings, 
the Prior Year Settings Transferred dialog box appears.

If you see the Prior Year Settings Transferred dialog box:

● Click Edit if you want to review and edit preferences and settings in the Options Setup 
Wizard before going to HomeBase.

● Click OK if you want to go to HomeBase without running the Options Setup Wizard. 
Proceed to “Transferring data from ProSeries 2003 client files” on page 21.

Using the Options Setup Wizard
The Options Setup Wizard starts automatically if the program wasn’t able to transfer the 
preferences and settings that you used with last year’s ProSeries program, or if you choose 
the Edit button in the Prior Year Settings Transferred dialog box.
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To set ProSeries options:

1 When the Options Setup Wizard starts, the first dialog box you see welcomes you to 
the Options Setup Wizard. Click Next to see the Options Setup Wizard dialog box 
that’s shown next.

2 Choose Express Setup or Custom Setup.

• If you select Express Setup, you see the Options Setup Wizard dialog boxes for the 
ProSeries options that you need to set before you complete returns.

• If you select Custom Setup, you first choose the areas of the program that you want 
to set up. The choices are Basic Options, Transfer Options, Printing Options, and 
Electronic Filing Options. Next, you see the Options Setup Wizard dialog boxes for 
the areas of the program that you chose.

3 Click Next.
Most Options Setup Wizard dialog boxes are self-explanatory. However, the next 
sections discuss the following three topics in some detail.
• “Entering firm and preparer information” (see below)
• “Entering global billing information” (see page 20)
• “Enabling and scheduling Task Scheduler tasks” (see page 20)

4 Continue setting ProSeries options in the Options Setup Wizard dialog boxes.

5 When the Congratulations dialog box indicates that you completed the Options Setup 
Wizard, click Finish to save the options that you selected.

6 Go to “Transferring data from ProSeries 2003 client files” on page 21.

Entering firm and preparer information
You enter information about your firm in the Firm/Preparer Information dialog box. If you 
completed the Connected Customer Wizard described on page 14, you’ll see your firm’s 
name and address in the gray area of the Firm Information section.

Tip: If you don’t see your firm’s name and address, you’ll retrieve that information from an 
Intuit Internet server later as explained in “Product licensing” on page 23.

Enter other information about your firm in the fields below the gray area. If the firm will 
be filing returns electronically, be sure to enter the firm’s Electronic Filing Identification 
Number (EFIN).

Choose Express 
Setup to quickly set 
up some essential 
program options.

Choose Custom 
Setup for a more 
detailed review of 
all program options. Click the Help 

button to see 
information 
about a dialog 
box.
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Enter information about the firm’s preparers in the next section of the dialog box. There’s 
room to enter information for many preparers. If preparers will be filing returns 
electronically, enter Electronic Return Originator (ERO) information in this section also. If 
the ProSeries program transferred preparer information from last year’s program, just edit 
the information as necessary.

Tip: For information about any field in the Firm/Preparer Information dialog box, right 
mouse click the field, then select About <Field> on the pop-up menu.

This table explains some of the fields in the Firm/Preparer Information dialog box:

Field Explanation

Firm Name and 
Address

This must be the primary firm name and location used by you in the normal 
course of business (in other words, the firm name and address under which 
you market yourself and your professional services). This information prints in 
the Paid Preparer area on each tax return for which you are the paid preparer.

If you prepare a return for which you are not the paid preparer, and you want 
to substitute an alternative “self-prepared return” or “non-paid preparer” 
designation in the paid preparer section of applicable forms instead of your 
company’s firm name and address, right mouse click on the Preparer Code 
field, then select About Preparer code on the pop-up menu to see specific 
directions on what to do in those situations.

You can’t enter or edit your firm’s name or address in the Options Setup 
Wizard. To edit information in the shaded area after you finish the Options 
Setup Wizard, go to the Tools menu, select Options, select Firm/Preparer Info, 
click the Edit button, then follow the on-screen instructions. To enter your 
firm’s name and address after you finish the Options Setup Wizard, go to the 
Tools menu, select License Products, select Online or Manual, then follow the 
on-screen instructions.

Preparer Code Enter a code of up to three characters to identify the preparer.
For example, enter the preparer's initials or a numeric code.
Each Preparer Code must be unique.

As you prepare returns, enter this same code on the client's Federal 
Information Worksheet (if an individual return) or in the preparer's block on 
the signature form (if a business return) to associate that return with a 
particular preparer.

Print name in 
signature area?

Check this box to print the preparer's name on the Preparer's Signature line of 
the tax return. The preparer can then write his or her signature on top of or 
next to his or her printed name.

During the product licensing 
procedure, your firm’s name and 
address are retrieved from an Intuit 
Internet server, then entered here.

Enter other information about your 
firm here.

Enter preparer and ERO 
information in this section.

To move to new fields, press 
ENTER or TAB, or use your mouse.
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Entering global billing information
Use the Global Billing Options dialog box to set the billing options that you want to use for 
all clients. Many billing options are available. If the ProSeries program transferred global 
billing information from last year’s program, just edit the information as necessary.

Tip: If Client Organizer is the only installed product, the Global Billing Options dialog box 
doesn’t appear.

Important: For detailed information about any field in the Global Billing Options dialog 
box, right mouse click the field and select About <Field> on the pop-up menu.

Entering your Customer Number and ZIP code
If the Customer Information dialog box appears, verify or enter your Customer Number 
and ZIP code, then click Next. You can find your Customer Number and ZIP code in the 
Sold To: area in the upper-left corner of the packing slip that came with the product.

Enabling and scheduling Task Scheduler tasks
ProSeries Task Scheduler automates several tasks for you. Typically, you set up Task 
Scheduler to perform tasks late at night, when you aren’t using your computer.

The ProSeries Task Scheduler dialog box identifies the tasks that Task Scheduler can 
perform for you automatically. Initially, all tasks are disabled. Click the check box for each 
task that you want to enable. When you enable at least one task, this dialog box indicates 
the days and time that Task Scheduler is scheduled to perform the enabled tasks.

Tip: If Client Organizer is the only installed product, the Receive E-file related 
Acknowledgments task isn’t available.

Self-employed? Select this box if you want ProSeries to check the Self-Employed box in the 
Paid Preparer area of the tax returns that the preparer prepares.

Checking the Self-employed box does not replace the firm’s name with the 
preparer's name, even if the preparer is self-employed. The firm name always 
prints on the returns for which you are the paid preparer.

Field Explanation

This dialog box has seven sections:

1 Tax Preparation Fees

2 Hourly Charges

3 Per Form Charges

4 Miscellaneous Fees and Adjustments

5 Discount

6 Sales Tax

7 Standard Paragraph
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Important: We recommend that you enable the Download New/Update Existing Products 
task to help keep your ProSeries tax products current. If you will be filing returns 
electronically, we also recommend that you enable the Receive E-file related 
Acknowledgments task. If you click the Modify Schedule button, you’ll see the Modify 
Schedule dialog box.

Important: If you schedule tasks to run during the night, the computer must be running 
and Task Scheduler must be able to connect to the Internet “unattended.” If your Internet 
connection requires a password, that password must be stored and available.

To see more information about Task Scheduler after you finish setting up the program:

● Use the Search Help feature on the Help toolbar, or
● Click the User’s Guide button on the toolbar, then go to chapter 5, “Task 

Scheduler.”

Tip: To run the Options Setup Wizard whenever you want from within ProSeries, 
go to the Help menu and choose Options Setup Wizard.

To see detailed information about ProSeries options after you finish setting up the 
program:

● Use the Search Help feature on the Help toolbar, or
● Click the User’s Guide button on the toolbar, then go to chapter 3, “Setting 

ProSeries Options.”

Transferring data from ProSeries 2003 client files
The transfer procedure is a simple way to start your clients’ ProSeries 2004 client files 
using the relevant data in their ProSeries 2003 client files.

When you complete the Options Setup Wizard 
or choose OK in the Prior Year Settings 
Transferred dialog box the first time you start 
the ProSeries program, you are asked if you 
want to transfer last year’s client files.

Tip: You can transfer data from 2003 ProSeries/1040 client files to 2004 Client Organizer 
files or to 2004 ProSeries/1040 client files. If you transfer data from 2003 ProSeries/1040 
client files to 2004 Client Organizer files, you can transfer data from those 2004 Client 
Organizer files to 2004 ProSeries/1040 client files later.

To enable a task, click the check box. 

This line identifies the current schedule.

To change the current schedule, click 
here. (At least one task must be 
enabled.)
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If you used ProSeries software last year, click Yes to go to the Transfer window, then do the 
five steps listed on the left side of the Transfer window.

Important: When transferring client data on a network, the location in the Transfer data 
files to... field (step 3) must be the directory where your ProSeries 2004 client files are 
being saved. This directory is set from the ProSeries Admin workstation during the Options 
Setup Wizard (or in the Directories section of the Options dialog box).

When you click Transfer, the ProSeries program creates a new 2004 client file for each 
client whose data is being transferred, then transfers the applicable data into the new 
ProSeries 2004 client file.

The Batch Transfer Status dialog box keeps you informed during the Transfer process, and 
the Transfer Log dialog box appears when the ProSeries program finishes transferring 
client data.

Review the information, then click Close to go to HomeBase. HomeBase is discussed in 
“Preparing your clients’ federal and state returns” on page 27.

Electronic filing. If a 2003 return was marked for electronic filing, that selection is 
transferred to the 2004 return. PINs are not transferred. If a client’s 2004 federal return will 
be electronically filed using a PIN instead of Form 8453, open the client’s 2004 federal 
return, then go to the IRS e-file Authentication Statement.

Tip: For on-screen instructions, go to the Help menu, choose Help Center, select Tutorial 
Videos, then choose Transferring Prior Year Data.

For more information about transferring data from ProSeries 2003 client files:

● Use the Search Help feature on the Help toolbar to find the information that you want, 
or

● Click the User’s Guide button on the toolbar, then go to chapter 9, 
“Transferring Client Data and Practice Information.”

1
Select the type of transfer 
you want to perform from 
the list of alternatives.

2
Select the location of your 
existing client files.

3
Select a location for the 
new client files.

4
Select the client files that 
you want to transfer data 
from, or click the Select 
All button.

5
After you’ve selected one 
or more clients, click 
Transfer.
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Product licensing
Product licensing is a system that licenses your ProSeries tax software to your firm. 
Product licensing is required before you can print returns or file returns electronically. 
Products that aren’t licensed for unlimited use can be used on a Pay-Per-Return basis. 
Product licensing no longer requires access codes.

Product licensing uses your Customer Number and ZIP code with information in Intuit’s 
records to deliver the following to your ProSeries tax software:

● An unlimited-use license for each ProSeries tax product and ProSeries electronic 
filing product that you’ve purchased for Unlimited use—even if those products haven’t 
been installed yet

● Your firm’s name and address

Tip: You can make non-significant changes to your firm’s name and address (such as 
changing “Dr.” to “Drive”) after ProSeries product licensing has occurred.

ProSeries product licensing can be performed using the Online method or the Manual 
method. For most ProSeries users, product licensing occurs online automatically.

Automatic, Online product licensing
The Connected Customer Wizard performs product licensing automatically when:

● You install ProSeries tax software for stand-alone use on a computer that has an 
Internet connection

● You install ProSeries tax software for network use from a computer (referred to as the 
ProSeries Admin workstation) that has an Internet connection

Important: When ProSeries is installed for network use, product licensing must be 
initiated from the ProSeries Admin workstation. Product licensing information is shared by 
all computers that have been set up as ProSeries workstations. See the Network Installation 
Guide for information about network install codes.

Be sure to read “Updating your firm’s product licensing information” on page 24.

Product licensing using the Manual method
If automatic, Online product licensing hasn’t been performed (as explained above), you’ll 
see the message “Product Licensing Required” in the HomeBase Message Center. When you 
click that message, you see a License Products dialog box that includes two options: Online 
(Recommended) and Manual. Select Manual, then click OK. You’ll see the License Products 
dialog box shown on the next page.

Tip: The three ways that you can contact Intuit for manual product licensing are:

● Automated Touch Tone phone service (call 1-800-723-0692)
● Online service (go to www.proseries.com, then select Product Licensing)
● Talk to a Customer Service representative (call 1-800-374-7317)
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Be sure to read “Updating your firm’s product licensing information” below.

Product licensing with multiple, non-Internet computers
If you install ProSeries for stand-alone use on computers that don’t have an Internet 
connection and you don’t want to perform product licensing for each computer using the 
Manual method, here’s a convenient way to copy your firm’s product licensing information 
from one computer to the other computers.

1 From the computer with your firm’s product licensing information, go to the File 
menu, choose Copy Product License, then use the dialog box to save the product 
license file to a network location or removable media (such as a 3.5-inch disk).

2 From each computer that requires product licensing, go to the File menu, choose 
Retrieve Product License, then use the dialog box to retrieve the product license file 
that you copied to the network location or removable media.

Tip: Repeat this procedure if you update the firm’s product licensing information.

Updating your firm’s product licensing information
Update your firm’s product licensing information when:

● You purchase additional ProSeries tax products or additional ProSeries electronic 
filing products for Unlimited use, or

● The software or an Intuit ProSeries representative instructs you to update your product 
license information

If either of these situations occur, go to the Tools menu, choose License Products, select 
Online or Manual, then click OK.

● If you chose Online, simply wait for the product licensing procedure to conclude.
● If you chose Manual, just follow the instructions in the License Products dialog box 

shown at the top of this page.

1
Verify your Customer Number and ZIP code.

2
Enter your firm’s name and address.
(This information must match the 
information contained in Intuit’s records.)

3
Click the Get Key Code button so the 
program will generate a unique Key Code.

4
Contact Intuit using one of three methods. 
After you provide the Key Code that was 
generated, you will receive a unique 
Licensing Code from Intuit.

5
Enter the Licensing Code, then click OK.
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Keeping your ProSeries tax products up-to-date
You can install new products and update previously-installed products via the Internet and 
from ProSeries CDs that you receive, as explained in this section. Getting tax products and 
updates via the Internet helps you have the most up-to-date versions of the ProSeries tax 
products that you use.

Software service and delivery information
When you placed your ProSeries order, you selected one of two CD delivery options. 
Details related to these options are shown below.

For information on release dates and news specific to the products you purchase, log in to 
your personalized www.my.proseries.com page. For other information about product 
release dates, go to http://www.proseries.com/support/release_dates.aspx.

Step 1 - Get products and updates via the Internet
In between CD shipments, you can use the Internet to get any newly-released products and 
product updates (if ProSeries is installed on a computer with Internet access). As soon as a 
ProSeries tax product or tax product update becomes available, it is posted to the ProSeries 
Tax Products Internet server.

Task Scheduler provides the easiest way to get ProSeries tax products and tax product 
updates via the Internet.

To use Task Scheduler, take the following steps from each computer on which the ProSeries 
program is installed for stand-alone use. If the ProSeries program is installed for network 
use, take these steps from the ProSeries Admin workstation.

ProSeries 
CD name

Approximate 
ship date

Option 1 
(3 CDs)

Option 2 
(5 CDs)

The CD includes these
ProSeries tax products

Head Start 
CD

Week of 
November 15

X X Client Organizer, plus the ability to 
download tax products when they 
become available for download 
starting in mid-December

Tax
Release 1 
CD

Week of 
December 27

X X Initial 1040, 1120, 1120S, 1065, 706, 
709, individual state products, and 
business state products

Tax
Release 2 
CD

Week of 
January 24

X Final 1040, 1041, remaining 
individual state products, and
most business state products

Tax
Release 3 
CD

Week of
February 14

X 1040NR, 990, remaining business 
state products, and other products,
if necessary

Archive
CD

Week of
March 28

X X All final products
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1 Go to the Tools menu, choose Options, then select Task Scheduler on the left side of 
the Options dialog box.

2 Enable the Download New/Update Existing Products task. (There’s a check in the box 
before the task when it’s enabled.)

3 If you want to change the Task Scheduler schedule, click Modify, then select the day(s) 
and time that are convenient for you.

4 Make sure the computer is on when Task Scheduler is scheduled to perform tasks.

Password. Task Scheduler must be able to connect to the Internet “unattended.” If your 
Internet connection requires a password, that password must be stored and available.

Tip: There’s another way to get ProSeries tax products and tax product updates via the 
Internet. Go to the Help menu and choose Update Installed Products/Download New 
Products.

Step 2 - Get products and updates from ProSeries CDs
The following procedure explains how to install ProSeries tax products and tax product 
updates from ProSeries CDs that you receive after you’ve installed the program from the 
first ProSeries CD.

1 Insert the ProSeries CD into your CD drive.

2 Allow the installation program to install the appropriate ProSeries tax products and 
tax product updates from that ProSeries CD.

3 If you want to review the products that are selected for installation or select additional 
products for installation, click the Select Additional Products button.

4 After you review the products that are selected for installation or select additional 
products for installation in the Tax Year 2004 Product Selections dialog box, click OK.

Tip: The on-screen ProSeries User’s Guide will be updated, if applicable.

Network. When a ProSeries tax product is installed or updated on the network drive from 
the ProSeries Admin workstation, that tax product or tax product update becomes available 
to all workstations on which you installed and set up the ProSeries program.

Important: The ReadMe information for the initial release of a product identifies any 
forms that are not ready to be filed yet. If you print a form that can’t be filed yet, the 
printed form includes a “DO NOT FILE” watermark. The ReadMe information for 
subsequent releases of a product identifies any forms that couldn’t be filed with the 
previous release of the product that can now be filed with the current release.

For more information about keeping your ProSeries tax products up-to-date:

● Use the Search Help feature on the Help toolbar, or
● Click the User’s Guide button on the toolbar, then go to chapter 2, “Updating 

ProSeries Tax Products.”
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Preparing your clients’ federal and state returns
After you complete the first-time start-up procedures, you see ProSeries HomeBase. 
HomeBase summarizes information about your clients and client files.

From HomeBase, you start new client files, open existing client files, and perform a variety 
of other tasks involving your client files, such as electronic filing.

The first time you start the ProSeries program, you see client information in HomeBase 
only if you transferred information from last year’s ProSeries client files. As you work on 
client returns and save client data this year, you’ll see information about those clients in 
HomeBase.

To see information about the clients who meet specific criteria, click the HomeBase View 
field near the top-left corner of HomeBase, then select the HomeBase view that you want 
from the HomeBase View list.

The ProSeries federal products that are installed determine which HomeBase views are 
available. ProSeries federal products are 1040, 1040NR, 1065, 1120, 1120S, 1041, 990, 706, 
709, and Client Organizer. If appropriate, the HomeBase View list also includes “EF Center” 
and “Bank Products.” The last entry on the HomeBase View list is “All Tax Returns.”

Tip: If you install Client Organizer from the HeadStart CD, the HomeBase View list 
contains only “Organizer for 1040” and “All Tax Returns.”

State products aren’t reflected in the HomeBase View list. With ProSeries, you start new 
federal returns and open previously-saved federal returns from HomeBase, but you start 
new state returns and open previously-saved state returns from the client’s federal return.

User’s Guide

Menu bar

Select a 
HomeBase 
View to see 
information 
about a 
specific set 
of clients.

Create New Client File HelpOptionsGo to EF Center Search Help
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Double-click 
a client file 
to open it.

Use the 
scroll bars 
to see all 
rows and 
columns of 
client 
information. 

Check the 
Message 
Center for 
important 
messages.
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Starting and opening federal returns
When you start a new federal return or open a previously-saved federal return, the 
Information Worksheet designed for that type of return opens in the Client Data window.

From the Client Data window, you can:

● Open forms, schedules, and worksheets
● Enter, edit, and delete data for the current client
● Check the current client’s return for errors
● Save the current client’s data in a client file
● Import data from Quicken, QuickBooks, or other software
● Set up ProSeries options and features
● Get information and help

The Federal Information Worksheet, which is the starting point for all Form 1040 returns, is 
shown next.

Important: To get information about a specific topic and your use of ProSeries software, 
enter keywords or a question in the Search Help field on the Help toolbar, then click 
Search. If you want information about a specific type of return, start or open a return of 
that type before you start the search.

Menu bar 

Toolbar

Help toolbar

Forms Bar

Categories 
are in all 
capital letters

To open a 
form or 
category, 
double click it

Worksheets 
for a form 
are listed 
below the 
form

Click these 
tabs to see 
different 
Forms Bar 
views

Save client data Go to state return User’s GuideSearch Help Help

Name of current form     Current data field     Type of data field selected     Scroll bar
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Opening forms, schedules, and worksheets
The ProSeries program offers several ways to open forms, schedules, and worksheets, 
including the Forms Bar, QuickZooms, the Open Forms dialog box, and Index forms.

Using the Forms Bar
When a client’s federal or state return is open, the Forms Bar on the left side of the Client 
Data window lists forms, schedules, and worksheets for that return. To open a form from 
the Forms Bar, double-click it, or select it then press ENTER.

Tip: In the Forms Bar, letters or numbers that are blue are keyboard shortcuts. The 
keyboard shortcut for many numbered forms are the form’s number, and the keyboard 
shortcut for many lettered schedules are the schedule’s letter.

The Forms Bar has four views. Click the tabs at the bottom of the Forms Bar to select the 
view that you want.

Note the following about each Forms Bar view:

● All Forms by Number – Shows all the forms, schedules, and worksheets for 
the type of return you’re preparing, with forms listed by number, schedules 
by letter, and brief descriptions of worksheets.

● All Forms by Description – Shows all the forms, schedules, and worksheets 
for the type of return you’re preparing, with forms, schedules, and 
worksheets grouped by category and including complete descriptions.

● Forms In Use – Shows only forms, schedules, and worksheets containing 
data for the open return. You can identify each copy of forms for which 
you’ve prepared more than one copy.

● Custom Forms – Shows the forms that you use most often for the type of 
return you’re preparing. You use the Customize Forms Bar command on the 
Tools menu to identify those forms.

Tip: When you move your mouse pointer over an entry in the Forms Bar, the complete 
entry appears in a “fly-over” box if the entry is wider than the Forms Bar.

.

Tip: Click the right mouse button in the Forms Bar to see the Forms Bar 
menu. You can use this menu to unpark the Forms Bar (if you want to 
move it) and to park it (at the left side of the Client Data window).

Using QuickZooms
Many ProSeries forms include QuickZoom buttons and QuickZoom icons.

● Click a QuickZoom button on a form to quickly open a related form.

● If you see a QuickZoom icon when you select a field on a form, 
click the QuickZoom icon to quickly open a related form.

All Forms by Number

All Forms by Description Forms in Use

Custom Forms
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Using the Open Forms dialog box
The Open Forms dialog box is similar to the Forms Bar. Click the Open Forms 
button on the toolbar to see the Open Forms dialog box, then open forms from 
the dialog box.

To open a form from the Open Forms dialog box, double-click it, or select it, then click OK.

Tip: In the Open Forms dialog box, letters or numbers that are blue are keyboard shortcuts. 
The keyboard shortcut for many numbered forms are the form’s number, and the keyboard 
shortcut for many lettered schedules are the schedule’s letter

Using Index Forms
Most federal returns and some state returns include categories for forms that appear in all 
capital letters in the Forms Bar and the Open Forms dialog box. Double-click a category to 
open the Index form that helps you find the form that you want. Shown next is the Where 
to Enter Efile and Bank Product Information Index form for Form 1040 returns.

If you select All Forms, the 
program can list forms by 
number or by description.

If you select Forms in Use, 
the forms are always listed 
by description.

Click a QuickZoom 
button near the top 
of the form to go to 
that part of the 
Index form.

Click a QuickZoom 
button in a part to 
go from the Index 
form to the listed 
form.



Preparing Returns 31

Preparing more than one copy of a form
When applicable, you can prepare more than one copy of some forms. For example, you 
can prepare more than one copy of the Form W-2 Worksheet, Schedule C, or Form 4562 
for individual federal returns.

When you open a form for which more than one copy is 
available, the Multiple-Copy Form dialog box appears.

● If you want to open an existing copy of the form, 
click Select an existing form to open, select the 
name of the copy that you want, then click Select.

● If you want to prepare a new copy of the form, 
click Create new copy, enter an applicable name 
for the copy, then click Create.

For detailed information about forms navigation:

● Use the Search Help feature on the Help toolbar, or
● Click the User’s Guide button on the toolbar, then go to chapter 13, “Using 

Forms and QuickEntry Sheets.”

Entering data on forms, schedules, and worksheets
As you select fields on the tax forms, schedules, and worksheets in your clients’ returns, 
you’ll see that some fields are available for data entry while other fields are calculated by 
the ProSeries program from data in the clients’ returns.

● Data that you enter appears blue.
● Data that the program transfers (from another last year’s return, from this year’s 

Client Organizer, or from the federal return to a state return) appears aqua.
● Data that the program calculates appears black.
● Other types of data appear in other colors. For example, data that the program 

determines is invalid, such as an invalid Social Security Number, appears red.

When you enter data, keep the following in mind:

● Press ENTER after each entry.
● When you enter a dollar-and-cents amount or a percentage, include the decimal 

point. The program rounds amounts to the nearest dollar.
● When you enter an amount of more than three digits, the program adds the comma.
● When you enter a negative number, type the minus key before the amount.
● If the program shows one or more ways to complete the data entry that you’ve begun 

(because the Use AutoFill option is selected):
• Press ENTER to accept the suggested data if it’s correct, or
• Select the correct alternative from the list of suggested data and press ENTER, or
• Continue typing the correct data.

Important: As you enter data, go to the toolbar and click the Save Client Data 
button frequently.

For detailed information about data entry:

● Use the Search Help feature on the Help toolbar, or
● Click the User’s Guide button on the toolbar, then go to chapter 13, “Entering 

Data on Forms and QuickEntry Sheets.”
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Summary of the basic steps to prepare client returns
The following table presents a brief summary of the basic steps to prepare client returns. 
Note that many optional steps aren’t included in this table.

To do this... Do this...

1. Start the client’s 
federal return 
from HomeBase

If you transferred last year’s data, select the appropriate HomeBase view, 
then double-click the client’s name to open the client’s file.

If you didn’t transfer last year’s data, click the Create New Client File button 
on the HomeBase toolbar, then select the appropriate federal product.

The appropriate Information Worksheet appears.

2. Prepare the 
client’s federal 
return

a. Import - If there’s relevant client data in QuickBooks, Quicken, or another 
program, go to the Import menu and choose the applicable command.

b. Enter data - Enter data in the applicable data fields. Double-click forms in 
the Forms Bar to see them.

c. Save the data - Click the Save Current Client File button on the toolbar 
often as you enter data.

d. Review - Click the Final Review button on the toolbar to correct errors that 
the ProSeries program identifies.

3. Prepare the 
client’s state 
return

a. Go to state - Click the Go to State Return button on the toolbar, then 
select the appropriate state.

b. Enter data - Enter data in the applicable fields on the state forms.

c. Save the data - Click the Save Current Client File button on the toolbar 
often as you enter data.

d. Review - Click the Final Review button on the toolbar to correct errors that 
the ProSeries program identifies.

e. Go to federal - Click the Go to Federal Return button on the toolbar to 
return to the client’s federal return.

f. Prepare additional state returns - Repeat these steps for any other state 
returns that the client must file.

4. Go to 
HomeBase

Click the HomeBase button on the toolbar.

5. Open the 
client’s return(s)

a. Select the appropriate HomeBase view.

b. Double-click the client’s name in HomeBase to open the client’s file (if you 
want to enter or review data).

6. Print the 
client’s return(s)

a. Select the appropriate HomeBase view, then select the client in HomeBase.

b. Go to the File menu, choose Print Center, then select Print Clients.

7. File the 
return(s) 
electronically

a. Make sure each return you want to file electronically is marked for 
electronic filing on the Federal Information Worksheet, and that it passes 
Final Review.

b. Click the Go to EF Center button on the toolbar, then select the client’s 
return(s) in the EF Center.

c. Go to the E-File menu, point to Electronic Filing, then choose Convert/
Transmit Returns and Extensions.
d. After 24 to 48 hours, click the Go to EF Center button on the toolbar, go to 
the E-File menu while in the EF Center, point to Electronic Filing, then 
choose Receive Acknowledgments.
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For more information about HomeBase, client returns, and client data, use the Search Help 
feature, or click the User’s Guide button on the toolbar, then go to the following chapters:

● Chapter 10, “Client Organizer”
● Chapter 12, “Using Forms and QuickEntry Sheets”
● Chapter 13, “Entering Data on Forms and QuickEntry Sheets”

Setting up other ProSeries features
Use the information in the following table to set up the following ProSeries features.

For information about setting, reviewing, and changing ProSeries options or 
features, use the Search Help feature on the Help toolbar, or click the User’s Guide 
button on the toolbar, then go to the following chapters:

● Chapter 3, “Setting ProSeries Options.”
● Chapter 4, “Setting Up ProSeries Features.”

To do this... Do this...

Set up an Internet connection so you can use 
ProSeries connectivity features

Go to the Help menu and choose Internet 
Connection Setup.

License your ProSeries tax products so you 
can print and file returns electronically

Go to the Tools menu, choose License Products, 
then select Online or Manual.
(We recommend that you select Online.)

Add funds to a Pay-Per-Return account so 
you can print and file returns electronically 
(for products you’re using on a pay-per-
return basis)

Go to the Tools menu, choose Pay Per Return, then 
select Increase Account Balance.

Activate the billing clock so it tracks the time 
you spend on each return

Go to the Tools menu, choose Billing, then choose 
Billing Clock.

Set billing rates for the forms and schedules 
of a specific type of return

After you open a return of the applicable type, go 
to the Tools menu, choose Billing, then choose 
Rates Per Form.

Sign up for merchant account services so 
you can accept payment by credit card and 
eChecks

Go to the Tools menu, choose Accept Credit Cards/
eChecks, then choose Sign Up.

Select options for slip sheets to use with 
envelopes and presentation folders

Go to the Tools menu and choose Global Slip Sheet 
Options.

Enter data that applies to all your clients 
who file a specific type of federal return

Go to the Tools menu and choose Edit Client 
Template.

View or edit the standard invoice for a 
specific type of return

Open a return of that type, go to the Tools menu, 
choose Billing, then choose View Invoice or Edit 
Invoice.

View or edit the standard client letter or 
standard recipient letter for a specific type of 
return

Open a return of that type, go to the Tools menu, 
choose Letters, then choose View Client Letter or 
Edit Client Letter.
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Getting information and help
The ProSeries Help system includes a Help toolbar with three features to help you get the 
information that you need quickly and easily. From left to right, those features are
Field/Form Help, Hot Topics, and Search Help.

Search Help
To get answers to a question or information about a key word or phrase, type the question, 
word, or phrase in the Search Help field, then press the ENTER key or click the Search 
button next to the Search Help field. The program searches ProSeries Help content, then 
lists the search results in the Help Center. Click the blue, underlined title of a search result 
to see the full content of that information source in the Help Center or a browser window.

Hot Topics
Hot Topics are top support topics that are linked to information in ProSeries Help. Click a 
Hot Topic to see the relevant information in the Help Center.

Field/Form Help
When you’re working on a return, the left area of the Help toolbar shows information 
about the currently-selected field or form. Click the blue, underlined word “more” to see all 
the current Field/Form Help information in the Help Center. Field/Form Help includes Tax 
Help, Cross-references, and Government Instructions.

Help toolbar

Field/Form Help Hot Topics Search Help
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Using the Help Center
All three features in the Help toolbar—Field/Form Help, Hot Topics, and Search Help—open 
the Help Center. From the Help Center, you can get a variety of information quickly from 
one, easy-to-use location.

The Help Center is divided into the following four sections:

● Tax Return Help — Provides information about the open tax return
- Includes Tax Help, Government Instructions, and Cross References

● ProSeries Help — Provides information about using the ProSeries program
- Includes User’s Guide, Program Help, and Tutorial Videos

● Technical Support — Provides important product information
- Includes Quick Answers and ReadMe Information

● ProSeries.com — Is a resource for online help tools and information
- Includes My ProSeries and Release Dates

Tip: The Help Center opens when you click the Help button on the toolbar.

For more information about ProSeries Help, use the Search Help feature on the 
Help toolbar to find the information that you want.

Search for a specific topic 
in Tax Help and Program 
Help here.

Click here to provide feedback that 
will help us improve ProSeries help.

Click here to see the 
previous information.

Click here to print 
the current topic.

Click and drag the splitter bar 
to adjust the window sizes.

Click here to close 
the Help Center.

Click here to maximize 
the Help Center.

Click the selections on the 
left side of the Help Center 
to see the corresponding 
information to the right.

Click a plus sign [+] to 
expand a selection.
Click a minus sign [-] to 
collapse a selection.

Click blue, underlined 
hyperlinks to see more 
about those topics.

Use the scroll bars to see all 
the information in the Help 
Center.
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Using the on-screen ProSeries User’s Guide
The ProSeries User’s Guide is an excellent source of information for all aspects of using 
ProSeries software. The User’s Guide is automatically installed on your system so its 
contents can be searched by the Search Help feature.

Here are three ways that you can open the ProSeries User’s Guide:

● In the ProSeries program., go to the toolbar and click the User’s Guide button.
● In the ProSeries program, go to the Help Center and choose User’s Guide.
● From the Windows desktop:

1. Go to the taskbar and click Start.
2. On the Start menu, point to Programs, then point to ProSeries 2004.
3. From the ProSeries 2004 menu, choose User’s Guide.

When the ProSeries User’s Guide opens, you see the title page and Table of Contents in the 
ProSeries User’s Guide browser window.

● Click a topic in the Table of Contents to see that information in the display area to the 
right of the Table of Contents.

● Use the scroll bars to see all the information in the Table of Contents and the display 
area.

● Click blue, underlined words and phrases to see more information about those topics.
● Click the Printer icon in the upper-right corner of the browser window to print the 

current topic.
● Click the Index and Search tabs to use those User’s Guide features.

Tip: For detailed information about the various ways to get information and help 
about ProSeries software, open the ProSeries User’s Guide, then go to chapter 1, 
“Getting Help.”

Using ProSeries.com and My ProSeries.com
ProSeries.com (www.proseries.com) includes up-to-date information about ProSeries 
products and services.

My ProSeries.com provides content that’s customized for you, such as:

● Status of your orders, and release dates of products you’ve purchased
● A way to complete product licensing manually
● Technical Support answers to current support issues
● Chat support with a ProSeries technical support agent
● E-mail support with historical logs of your e-mail correspondence
● Links to various helpful Web sites

Important: You must set up an account to use My ProSeries.com so we can provide you 
with information specific to your ProSeries products.
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Filing returns electronically
ProSeries/Electronic Filing software is installed with ProSeries tax products that support 
electronic filing. ProSeries software supports electronic filing of the following:

● Federal individual returns and extension request forms
● State individual returns (for 42 states)
● Michigan Single Business Tax returns
● Massachusetts corporation, S corporation, partnership, and fiduciary returns
● Massachusetts corporation and S corporation extension request forms

To visit the Web site for a state’s tax agency, go to www.proseries.com, choose Resources, 
click Web sites in the State and federal tax links section, then click the name of the state.

Important: If you don’t have an IRS-issued Electronic Filing Identification Number 
(EFIN) yet, see “Preparing for electronic filing” on page 4.

Tip: For on-screen instructions about electronic filing, go to the Help menu, choose Help 
Center, select Tutorial Videos, then choose Electronic Filing – Overview, Electronic Filing – 
Preparing a Return, or Electronic Filing – Preparing an Extension.

For detailed information about electronic filing:

● Go to www.proseries.com, then select E-Filing, or
● Use the Search Help feature on the Help toolbar, or 
● Click the User’s Guide button on the toolbar, then go to chapter 20, 

“Electronic Filing.” 

Establishing an Internet connection
To file electronically, you need to be able to connect to the Internet from the computer on 
which the ProSeries program is installed.

If you don’t have an Internet connection, you must first sign up for service with an 
Internet Service Provider (ISP). Once you have an ISP, go to the Help menu, choose 
Internet Connection Setup, then follow the instructions in the dialog boxes.

Setting up the ProSeries program for electronic filing
If you’ve already entered your electronic filing information, proceed to “Step 1 - Mark the 
return(s) for electronic filing” on page 39.

If you haven’t entered your electronic filing information yet, take the following steps to 
set up the ProSeries electronic filing options.

1 Go to the Help menu and choose Options Setup Wizard.

2 In the first Options Setup Wizard dialog box, select Express Setup.

3 In the Firm/Preparer Information dialog box, be sure to enter the firm’s Electronic 
Filing Identification Number (EFIN).
PINs. PINs (Personal Identification Numbers) are used as electronic signatures. When 
you use a PIN, you don’t mail Form 8453 to the IRS. If you’re going to participate in 
the IRS’ Practitioner PIN program, enter each preparer’s PIN. This is a five-digit code 
chosen by each preparer.
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4 In the Filing Client Returns Electronically dialog box, select Yes, some returns may be 
filed electronically.

5 In the Electronic Filing Contact Information dialog box, complete every field. (You can 
leave the Fax field blank.)

6 Complete the remainder of the Options Setup Wizard.

Tip: For on-screen instructions, go to the Help menu, choose Help Center, select 
Tutorial Videos, then choose Electronic Filing - Overview.

If more than one computer will be using the same EFIN
When ProSeries software is installed on a computer, the DCN (Declaration Control Number) 
counter is set at “00001.” The program assigns that number to the first federal return that’s 
marked for electronic filing, then increments the DCN counter by “1.” As each subsequent 
federal return is marked for electronic filing, the program assigns the current DCN to that 
return, then increments the DCN counter by “1.”

Important: If your firm will be filing returns electronically from more than one computer 
using the same EFIN on each one (and these computers are not networked), change the 
starting number in the DCN counter in the ProSeries program on all but one computer 
before preparers start to transfer or prepare returns. By advancing the DCN counter 
sufficiently in the ProSeries program on each “additional” stand-alone computer, each 
return marked for electronic filing will be assigned a unique DCN. For example, advance 
the DCN counter to “01001” on the second computer, to “02001” on the third computer, and 
so on.

Enter the firm’s EFIN here.

Enter the preparer’s PIN here.

ProSeries transfers your firm’s 
EFIN from the Firm/Preparer 
Information section of the 
Options Setup Wizard to this 
field.

If you entered Electronic Filing 
Contact Information in last 
year’s program, the program 
enters that information here.
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Tip: If a computer will be using a unique EFIN, it’s not necessary to change the starting 
number in the DCN counter for that computer.

To change the starting number in the DCN counter for a computer:

1 Go to the Tools menu, then choose Options.

2 Select Electronic Filing in the left side of the Options dialog box.

3 Go to the DCN Counter field and increase the number.

Important: The next sections focus on electronic filing and individual returns. For 
information about Michigan Single Business Tax returns, Massachusetts business returns, 
and Massachusetts corporate extensions, see “Michigan Single Business Tax returns, 
Massachusetts business returns, and Massachusetts corporate extensions” on page 46.

Step 1 - Mark the return(s) for electronic filing
To mark a client’s federal and state individual returns for electronic filing:

1 Open the client’s federal individual return, go to the Federal Information Worksheet, 
scroll down to Part IV - Filing Information, then make sure the appropriate preparer 
code is entered in the Preparer Code field.

Tip: If you’re acting as an ERO and filing a return for another preparer, enter that 
preparer’s preparer code in the Preparer Code field.

2 Make sure the Check this box to file the federal return electronically box is checked.

3 State returns. If you’re going to file the client’s state return (or returns) electronically, 
enter the appropriate information in the Choose state(s) to file electronically 
expanding table.
Note the following about the three EF filing types for state individual returns.

Check this box to file the federal return electronically.

Enter 
information 
about the 
state return(s) 
for electronic 
filing in this 
expanding 
table.

See Help if 
you need 
assistance.

Enter the Preparer Code here.
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Important: New York is a Fed/State or State-Only state this year.

4 Enter all other relevant information in the Filing Information section.

5 Direct Deposit/Direct Debit. If the client wants their refund deposited directly into 
their account or the balance due withdrawn from their account, complete Part V - 
Direct Deposit or Electronic Funds Withdrawal Information.

Step 2 - Prepare the return(s) for electronic filing
To prepare a client’s individual return(s) for electronic filing:

1 Complete the client’s federal return.

Tip: See “Avoiding common reasons for rejection” after Step 7.

2 Complete the Electronic Filing Smart Worksheets on the client’s Form W-2, 1099-R, 
W2-G, and 1099-G worksheets (if applicable).

EF filing type States Comments

Independent California, Illinois, 
Maine, 
Massachusetts, and 
Minnesota

Independent EF filing type state returns don’t have to 
be electronically filed with the corresponding federal 
return. Returns for these states are electronically filed 
directly with the state taxing authority.

Fed/State Hawaii, Oklahoma, 
and Oregon

Fed/State EF filing type state returns must be 
electronically filed with the corresponding federal 
return. Returns for these states are electronically filed 
to the IRS, then sent to the state taxing authority.

Fed/State or 
State-Only

34 states that aren’t 
an Independent 
state or a Fed/State 
state

Fed/State or State-Only EF filing type state returns 
don’t have to be electronically filed with the 
corresponding federal return. Returns for these states 
are electronically filed to the IRS, then sent to the 
state taxing authority.

Check this box to 
use direct deposit 
of any federal 
refund.

Check the 
appropriate Yes 
box in this area to 
use electronic 
funds withdrawal 
of a federal 
balance due (if 
using electronic 
filing).

Be sure to 
complete the rest 
of Part V.
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3 RAL or RT. If you’re participating in the ProSeries/Bank Products program and the 
client wants a Refund Anticipation Loan or Refund Transfer, complete the applicable 
parts of the Bank Product Information Worksheet.
For more information, see “Overview of Bank Products” on page 47.

4 Go to the toolbar and click the Go to State/City button.

5 Complete the client’s state return.

6 Go to the toolbar and click the Go to Fed button.

7 Go to the toolbar and click the Save Client button.

Avoiding common reasons for rejection

● Verify the client’s social security number (SSN) and Date of Birth (DOB) with the 
Social Security Administration (SSA).

● If you’re preparing a Married Filing Joint return, verify that the spouse’s last name on 
the return matches the spouse’s last name on his or her Social Security card.

● Make sure the employer’s name and federal identification number on the actual Form 
W-2 match the information you’ve entered in the ProSeries program.

● Make sure the payer’s name and federal identification number on the actual Form W-
2G or Form 1099-R match the information you’ve entered in the ProSeries program.

● Use error-checking during data entry. To do so, go to the View menu and make sure 
there’s a check mark before Error Alerts.

Step 3 - Run Final Review from the return(s)
After you complete a federal or state return, run ProSeries Final Review to help you check 
the return for errors.

1 To review the open federal or state return, go to the toolbar and click the 
Final Review button.We recommend that you select every option in the Final 
Review Choices dialog box.

2 Analyze the Final Review report, and fix all errors that are identified.

3 Click Recheck to check the return for errors.

Tip: A PIN is used as an electronic signature. An ERO Practitioner PIN can be any five 
digits (except all zeros). You enter your ERO Practitioner PIN in the Firm/Preparer Info 
section of the Options dialog box.

The Electronic Filing option of Final Review 
identifies conditions in the return that make 
the return ineligible for electronic filing.
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4 Using PINs. If you’re participating in the IRS Practitioner PIN program and the client 
wants to use a PIN, go to the IRS e-file Authentication Statement in the client’s federal 
return, make sure the box at the top of the form is checked, then complete the 
remainder of the form.
For more information, click the Help button while the IRS e-file 
Authentication Statement is open on the screen. Review the form and the 
return(s) with the client.

Tip: You’ll need to retain a completed copy of Form 8879, IRS e-file Signature 
Authorization, that’s been signed by the client.

5 Not using PINs. If you’re not participating in the IRS Practitioner PIN program, review 
Form 8453 in the client’s federal return. (If you’re participating in the IRS Practitioner 
PIN program, you don’t need to file Form 8453 with the IRS.) Also review the 
electronic filing paperwork form in the client’s state return, if applicable. Review the 
form(s) and return(s) with the client.

Step 4 - From the EF Center, select the return(s)
To select individual returns for electronic filing:

1 Go to the toolbar and click the Go to EF Center button to go to the 
HomeBase EF Center.
The HomeBase EF Center presents important information about each client 
return that you’ve prepared and marked for electronic filing, including the status of 
each return.

2 Select the individual returns that you want to file electronically. Their status should be 
Return Marked for EF.

E-File button The status should be Return Marked for EF.

Use the new 
Pending 
and 
Accepted 
tabs to filter 
the returns.

These 
returns are 
selected.
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• To select consecutive client returns, click the first client return, then hold down the 
SHIFT key and click the last client return.

• To select non-consecutive client returns, hold down the CTRL key while you click 
each client return.

State returns. State returns are listed after the corresponding federal return. Select a 
client’s federal and state returns at the same time.

Fed type. Individual returns (both federal and state) show 1040 in the Fed Type column.

Tip: While California, Illinois, Maine, Massachusetts, and Minnesota returns do not need 
to be electronically filed with the corresponding federal return, it’s best to do so. If an 
Arizona, North Dakota, or South Carolina return isn’t filed with the corresponding federal 
return, it can’t be electronically filed until the federal return is accepted.

Step 5 - Convert and transmit the selected return(s)
To electronically file the individual returns that you selected in step 4:

1 Go to the toolbar and click the E-File button.

2 If any informational dialog boxes appear, read the information, then click 
OK.

3 If you see a Pay-Per-Return dialog box, authorize payment for the indicated client 
files.

4 In the Electronic Filing Options dialog box, select 
Convert and Transmit selected returns/extensions.

5 Make sure Enable conversion error checking is 
selected.

Tip: A return that cannot pass error checking will 
usually get rejected by the IRS. Therefore, do not 
disable conversion error checking unless directed 
to do so by a Technical Support Representative.

6 Click OK.

When the ProSeries program finishes converting and transmitting the returns, the Transmit 
Electronic Filing Returns/Extensions Log appears so you can review the results.

Step 6 - Wait 24 to 48 hours, then check for 
acknowledgments
Tip: ProSeries automatically checks for acknowledgments when you transmit client 
returns. It may take more than 48 hours to receive an acknowledgment for some federal 
and state returns.

To check for acknowledgments from the IRS or state taxing authorities:

1 In HomeBase or from an open return, go to the toolbar and click the Go to 
EF Center button.

2 Click the client’s status in the Status column of the EF Center to open the 
client’s Electronic Filing Client Status History.

Tip: Entries in the Status column are blue and underlined. A client’s status becomes 
bold when your mouse pointer rests on it.
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3 Review the Electronic Filing Client Status History and identify the most recent status 
of the client’s return, then click Close.

Tip: If a client’s return was rejected, the report shows why it was rejected, and how to 
fix the error.

4 If the most recent status of the return is “Return Accepted,” proceed to “Step 7 - 
Complete the electronic filing process” on page 45.
If the most recent status of the return is “Return Rejected,” proceed to “Resolving a 
problem with a rejected return” that follows Step 8.
If the most recent status of the return isn’t “Return Accepted” or “Return Rejected,” 
continue with Step 5.

5 Go to the E-File menu and choose Electronic Filing.

6 From the Electronic Filing menu, choose Receive 
Acknowledgments to get the latest 
acknowledgments.

7 In the Receive Electronic Filing Acknowledgments 
Log, click View Acks to see the detailed Acknowledgment Report.
If there aren’t any acknowledgments, View Acks is not available. In most cases, you 
will receive a client’s federal acknowledgment before you receive the client’s state 
acknowledgment.

8 Review the information, then click Close. If the return was rejected, continue with 
“Resolving a problem with a rejected return” next.

Resolving a problem with a rejected return
To resolve a problem with a rejected return:

1 From the EF Center, go to the Electronic Filing menu, choose Reports, then print a 
Rejected Returns report.

2 Incorrect SSN. If a return was rejected because the taxpayer’s social security number 
wasn’t correct, print the Intuit Electronic Postmark Report before correcting the social 
security number and resubmitting the return. This provides the original date and time 
of filing.

3 Fix the errors in the rejected return.

4 Make sure the corrected return passes Final Review.

5 Convert and retransmit the corrected returns as explained in “Step 4 - From the EF 
Center, select the return(s)” on page 42 and “Step 5 - Convert and transmit the selected 
return(s)” on page 43.
Re-filing state returns. If you’ve filed a client’s federal and state returns together and 
the federal return is accepted but the state return is rejected, in most cases you can 
re-file the corrected state return electronically.
Hawaii, Oklahoma, and Oregon returns. You cannot re-file corrected Hawaii returns, 
Oklahoma returns, or Oregon returns electronically because they can only be filed 
with the client’s federal return. To re-file a corrected Hawaii return, Oklahoma return, 
or Oregon return, you must print the return, then mail it to the appropriate state 
taxing authority.
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Step 7 - Complete the electronic filing process
After the IRS or state taxing authority has accepted a return, take these steps to complete 
the filing process:

1 Using PINs. If you and your client are using PINs, you don’t need to mail Form 8453 
to the IRS (but you will need to retain a completed copy of Form 8879, IRS e-file 
Signature Authorization, that’s been signed by the client). However, you may need to 
mail state electronic filing paperwork to the appropriate state service center. Proceed 
to Step 3.

Tip: To determine if a client’s return was filed with PINs, go to the EF Center and 
scroll across to the PIN column. If the return was transmitted with a PIN, you’ll see a 
“Y” in the PIN column. If the return was transmitted without a PIN, you’ll see an “N” 
in the PIN column.
Not using PINs. If you and your client are not using PINs, attach any required paper 
documents to Form 8453, U.S. Individual Income Tax Declaration for an IRS e-file 
Return. Do this for each return that has been accepted, then continue with Step 2.

Tip: The Preparing Form 8453 section of the Electronic Filing Information Worksheet 
identifies the paper documents to attach to the client’s Form 8453.

2 After you’ve been informed the federal return was accepted, mail the completed Form 
8453 to the appropriate IRS service center within the time period required by the 
appropriate taxing authority.

Tip: The Mailing Form 8453 section of the Electronic Filing Information Worksheet 
shows the Form 8453 mailing address.

3 State forms. After you’ve been informed the state return was accepted, mail the 
completed state electronic filing paperwork to the appropriate state service center 
within the time period required by appropriate taxing authority (if the state taxing 
authority requires electronic filing paperwork).

4 Print Form 9325, Acknowledgment and General Information for Taxpayers Who File 
Returns Electronically, and give it to your client.
To print Form 9325:
a. Open the client’s federal return.
b. Go to the File menu, choose Print, then select Print Selected Forms.
c. Click Choose, select Form 9325: General Information for Electronic Filers, 

then click OK.
d. Click Print.
IRS refund cycle. For information about the IRS refund cycle, go to 
www.proseries.com, select Electronic Filing, select Other Useful Info, then select 
Refund Cycle.

5 Balance due. If you filed a balance-due return and your client did not elect to pay 
with a Discover Card or to have their bank account directly debited, print Form 
1040-V, Balance Due Payment Voucher, and give it to your client.
Federal taxes. If your client owes federal taxes, he or she must mail Form 1040-V and 
the payment to the IRS no later than April 15, 2005.
State taxes. If your client owes state taxes, complete the state tax payment voucher at 
the same time.
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6 Getting current information. To review common reject reasons, troubleshooting 
information, and frequently-asked questions from www.proseries.com, do either of the 
following:
• While in the ProSeries EF Center, go to the Steps to E-File section, then click the 

View Frequently Asked EF Questions button.
• While in your Internet browser, go to www.proseries.com, select E-Filing, then 

select E-Filing FAQs.

For detailed information about electronic filing, including instructions on how to file 
extension request forms electronically:

● Go to www.proseries.com, then select E-Filing, or
● Enter appropriate keywords or a question in the Search Help field on the Help toolbar, 

then click the Search button, or
● Click the User’s Guide button on the toolbar, then go to chapter 20, 

“Electronic Filing.”

Michigan Single Business Tax returns, Massachusetts 
business returns, and Massachusetts corporate extensions
The steps to file Michigan Single Business Tax returns and Massachusetts business returns 
electronically are similar to the steps to file federal and state individual returns 
electronically. However, note the following:

● If the client will be filing a federal corporation, S corporation, partnership, or 
fiduciary return, you mark the client’s Michigan Single Business Tax or Massachusetts 
business return for electronic filing on the Electronic Filing Information Worksheet in 
the client’s federal return. You can select Massachusetts or Michigan SBT.
Tip: If the client will be filing a federal individual return, you mark the client’s 
Michigan Single Business Tax return for electronic filing on the Federal Information 
Worksheet in the client’s federal return by selecting Michigan SBT.

● Fed type. The Fed Type column in the EF Center identifies the type of business return.
• Corporation returns (both federal and state) show 1120 in the Fed Type column.
• S Corporation returns (both federal and state) show 1120S in the Fed Type column.
• Partnership returns (both federal and state) show 1065 in the Fed Type column.
• Fiduciary returns (both federal and state) show 1041 in the Fed Type column.

● Return type. The Return Type column in the EF Center identifies the state return.
• Massachusetts business returns show MA in the Return Type column.
• Michigan Single Business Tax returns show MISBT in the Return Type column.

For detailed information about filing Michigan Single Business Tax returns, Massachusetts 
business returns, and Massachusetts corporate extensions electronically:

● Go to www.proseries.com, then select E-Filing, or
● Use the Search Help feature on the Help toolbar, or 
● Click the User’s Guide button on the toolbar, then go to chapter 20, 

“Electronic Filing.” 
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Overview of Bank Products
When you file your clients’ federal individual returns electronically, those clients may be 
eligible to receive a loan based on their expected federal refunds in the form of bank 
products such as Refund Anticipation Loans (RALs), Refund Transfers (RTs), and Refund 
Transfer Direct Deposits (RTDDs). In addition, your fees are deducted from the client’s 
refund and deposited into your bank account electronically.

As a general rule, a client is eligible for a bank product if:

● The client is due a federal refund, and
● You’re filing the client’s federal return electronically

ProSeries/Bank Products software through Santa Barbara Bank & Trust is included with 
ProSeries/1040 and integrates seamlessly with ProSeries/Electronic Filing. However, you 
can offer bank products through First Security Bank or Republic Bank instead of Santa 
Barbara Bank & Trust.

For more information about offering bank products through Santa Barbara Bank & Trust, 
First Security Bank, or Republic Bank:

● Go to www.proseries.com, select E-Filing, then select Bank Products, or
● Use the Search Help feature on the Help toolbar, or 
● Click the User’s Guide button on the toolbar, then go to chapter 21, “Bank 

Products.” 

The following table summarizes the basic steps for offering bank products to your 
clients through Santa Barbara Bank & Trust:

To take this step... Do this...

1. Apply to Santa Barbara Bank & 
Trust to participate in their bank 
products program.

Go to www.proseries.com, select E-Filing, then select Bank 
Products to apply to Santa Barbara Bank & Trust.

2. Set the ProSeries Bank Products 
options.

a. Go to the Tools menu, choose Options, then select Bank 
Products.
b. Select the Bank Products options that you want.

c. Click Registration Information, then enter the requested 
information in the Bank Products Registration Information 
dialog box.

3. Transmit your registration 
information to Santa Barbara 
Bank & Trust (any time after 
12:00 a.m. PST on 12/1/04).

a. Go to the HomeBase Bank Products view.

b. Go to the E-File menu, point to Bank Products, then 
choose Transmit Registration Information.

4. Check for the registration 
acceptance status from Santa 
Barbara Bank & Trust.

a. Go to the HomeBase Bank Products view.

b. Go to the E-File menu, point to Bank Products, then 
choose Receive Authorization/Status Information.
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For detailed information about bank products:

● Go to www.proseries.com, select E-Filing, then select Bank Products, or
● Enter appropriate keywords or a question in the Search Help field on the Help toolbar, 

then click the Search button, or
● Click the User’s Guide button on the toolbar, then go to chapter 21, “Bank 

Products.”

5. Prepare the client’s federal 
return for a bank product.

a. Prepare the client’s federal and state return(s).

b. Prepare the client’s federal return (and state return(s) if 
applicable) for electronic filing.

c. Complete the Bank Product Information Worksheet in the 
client’s federal return.

d. Review the client’s return(s) and make sure the return(s) 
successfully pass Final Review.

e. Print the Refund Application Loan (RAL) and Refund 
Transfer (RT) Application and Agreement form from the 
client’s federal return, and have the taxpayer(s) sign it.

6. File the client’s return(s) 
electronically.

a. Go to the EF Center and select the client’s return(s).

b. Go to the E-File menu, point to Electronic Filing, then 
choose Convert/Transmit Returns and Extensions.

7. Receive bank product print 
authorizations and status 
messages.

a. Go to the HomeBase Bank Products view.

b. Go to the E-File menu, point to Bank Products, then 
choose Receive Authorization/Status Information.

8. Print the client’s Refund 
Anticipation Loan or Refund 
Transfer check. (This step isn’t 
applicable for Refund Transfer 
Direct Deposits.)

a. If “Ready to Print” appears in the Status column of the 
HomeBase Bank Products view, select the client.

b. Go to the E-File menu, point to Bank Products, then 
choose Print Checks...
c. Deliver the check to the client.

9. If there’s a problem with a 
check, resolve the problem.

a. Go to the HomeBase Bank Products view and select the 
client whose check is affected.

b. Go to the E-File menu, point to Bank Products, then 
choose Resolve Check Problems...

10. View or print Bank Products 
reports.

a. Go to the HomeBase Bank Products view and select the 
client returns that you want to include in the report.

b. Go to the E-File menu, point to Bank Products, then 
choose Reports.

To take this step... Do this...


